© 2009 Quest Software, Inc.  
ALL RIGHTS RESERVED.  

This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a software license or nondisclosure agreement. This software may be used or copied only in accordance with the terms of the applicable agreement. No part of this guide may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written permission of Quest Software, Inc.

If you have any questions regarding your potential use of this material, contact:

Quest Software World Headquarters  
LEGAL Dept  
5 Polaris Way  
Aliso Viejo, CA  92656  
USA  
www.quest.com  
email: legal@quest.com

Refer to our Web site for regional and international office information.

Trademarks


Disclaimer

The information in this document is provided in connection with Quest products. No license, express or implied, by estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest products. EXCEPT AS SET FORTH IN QUEST’S TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR THIS PRODUCT, QUEST ASSUMES NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL QUEST BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF QUEST HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Quest makes no representations or warranties with respect to the accuracy or completeness of the contents of this document and reserves the right to make changes to specifications and product descriptions at any time without notice. Quest does not make any commitment to update the information contained in this document.

Quest ActiveRoles Server - User Guide  
Updated - August 31, 2009  
Software Version - 6.5
## CONTENTS

### ABOUT THIS GUIDE

- **INTENDED AUDIENCE**                      ........................................... 8
- **CONVENTIONS** ......................................................... 8
- **ABOUT QUEST SOFTWARE, INC.** ......................... 9
  - **CONTACTING QUEST SOFTWARE** ......................... 9
  - **CONTACTING QUEST SUPPORT** ......................... 9
- **INTRODUCTION** ........................................................ 10

### CHAPTER 1

**GETTING STARTED.** ...................................................... 11

- **STARTING THE ACTIVERoles SERVER CONSOLE** ..................... 12
- **GETTING AND USING HELP** ........................................... 12
- **USER INTERFACE OVERVIEW** ......................................... 13
  - **CONSOLE TREE** .................................................. 13
  - **DETAILS PANEl** .................................................. 14
  - **ADVANCED PANEl** ............................................. 14
- **VIEW MODE** ........................................................... 15
- **CONTROLLED OBJECTS** .............................................. 16
- **USING MANAGED UNITS** ............................................. 16
- **SETTING UP FILTER** ................................................ 18
- **FINDING OBJECTS** .................................................. 18
- **GETTING POLICY-RELATED INFORMATION** ......................... 20

### CHAPTER 2

**USER ACCOUNT MANAGEMENT** ......................................... 23

- **ABOUT USER ACCOUNTS** ............................................ 24
- **USER ACCOUNT MANAGEMENT TASKS** ............................. 24
  - **CREATING A USER ACCOUNT** .................................... 25
  - **FINDING A USER ACCOUNT** ..................................... 25
  - **COPYING A USER ACCOUNT** .................................... 26
  - **MODIFYING USER ACCOUNT PROPERTIES** ....................... 27
  - **RENAMING A USER ACCOUNT** .................................. 28
  - **DISABLING AND ENABLING A USER ACCOUNT** ................. 28
  - **RESETTINg USER PASSWORD** ................................... 29
  - **ADDITIONg USER ACCOUNTS TO GROUPS** ........................ 29
  - **REMOVING A USER ACCOUNT FROM GROUPS** ................... 31
  - **CHANGING A USER’S PRIMARY GROUP** .......................... 31
  - **PERFORMING EXCHANGE TASKS ON A USER ACCOUNT** ....... 31
  - **MOVING USER ACCOUNTS** ....................................... 32
  - **EXPORTING AND IMPORTING USER ACCOUNTS** ................. 32
DELETING USER ACCOUNTS.................................................. 32

CHAPTER 3
GROUP MANAGEMENT.......................................................... 33
ABOUT GROUPS................................................................. 34
GROUP MANAGEMENT TASKS.................................................. 34
CREATING A GROUP............................................................. 35
FINDING A GROUP............................................................... 36
COPYING A GROUP............................................................... 36
MODIFYING GROUP PROPERTIES............................................. 37
CHANGING GROUP TYPE AND GROUP SCOPE................................ 38
RENAMING A GROUP............................................................. 39
ASSIGNING A MANAGER OVER A GROUP................................. 40
ADDING MEMBERS TO A GROUP.............................................. 41
REMOVING MEMBERS FROM A GROUP...................................... 42
PERFORMING EXCHANGE TASKS ON A GROUP.......................... 42
MOVING GROUPS................................................................. 42
EXPORTING AND IMPORTING GROUPS.................................... 43
DELETING GROUPS............................................................... 43
ADMINISTERING QUERY-BASED DISTRIBUTION GROUPS.................. 44
ADMINISTERING DYNAMIC (RULES-BASED) GROUPS........................ 44
PUBLISHING A GROUP TO SELF-SERVICE MANAGER....................... 46
USING TEMPORAL GROUP MEMBERSHIPS.................................... 48
ADDING TEMPORAL MEMBERS.................................................. 48
VIEWING TEMPORAL MEMBERS............................................... 49
RESCHEDULING TEMPORAL GROUP MEMBERSHIPS........................... 49
REMOVING TEMPORAL MEMBERS............................................. 50

CHAPTER 4
COMPUTER ACCOUNT MANAGEMENT......................................... 51
ABOUT COMPUTER ACCOUNTS................................................ 52
COMPUTER ACCOUNT MANAGEMENT TASKS.................................. 52
CREATING A COMPUTER ACCOUNT........................................... 53
FINDING A COMPUTER ACCOUNT............................................. 53
MODIFYING COMPUTER ACCOUNT PROPERTIES............................. 54
DISABLING AND ENABLING A COMPUTER ACCOUNT......................... 55
RESETTING A COMPUTER ACCOUNT.......................................... 55
ADDING COMPUTER ACCOUNTS TO GROUPS................................ 55
REMOVING A COMPUTER ACCOUNT FROM GROUPS.......................... 56
MOVING COMPUTER ACCOUNTS................................................ 57
EXPORTING AND IMPORTING COMPUTER ACCOUNTS........................ 57
**DELETING COMPUTER ACCOUNTS** ........................................ 57

**CHAPTER 5**

**ORGANIZATIONAL UNIT MANAGEMENT** .............................. 59

- About Organizational Units ............................................. 60
- Organizational Unit Management Tasks ................................. 60
  - Creating an Organizational Unit ...................................... 60
  - Finding an Organizational Unit ...................................... 61
  - Modifying Organizational Unit Properties ......................... 61
  - Renaming an Organizational Unit .................................... 62
  - Moving an Organizational Unit ...................................... 62
  - Deleting an Organizational Unit .................................... 62

**CHAPTER 6**

**Management of Contacts** ............................................... 63

- About Contacts .......................................................... 64
- Contact Management Tasks ............................................... 64
  - Creating a Contact ...................................................... 65
  - Finding a Contact ....................................................... 65
  - Modifying Contact Properties ....................................... 66
  - Renaming a Contact .................................................... 67
  - Adding and Removing Contacts from Groups ..................... 67
  - Performing Exchange Tasks on a Contact ......................... 68
  - Moving Contacts ....................................................... 68
  - Exporting and Importing Contacts .................................. 69
  - Deleting Contacts ..................................................... 69

**CHAPTER 7**

**Management of Exchange Recipients** ............................... 71

- About Exchange Tasks ................................................... 72
- Exchange Tasks on User Accounts ..................................... 73
- Exchange Tasks on Groups .............................................. 74
- Exchange Tasks on Contacts ............................................ 74
- Managing Exchange-related Properties ............................... 74
  - Exchange General Tab ............................................... 75
  - E-mail Addresses Tab .................................................. 76
  - Exchange Advanced Tab ............................................... 77
  - Mailbox Features Tab .................................................. 78
  - Resource Information Tab ............................................ 79
  - Master Account Tab ................................................... 80
  - Mailbox Sharing Tab ................................................... 80
About This Guide

- Intended Audience
- Conventions
- About Quest Software, Inc.
- Contacting Quest Software
- Contacting Quest Support
- Introduction
Intended Audience

This document has been prepared to assist you in becoming familiar with the Quest ActiveRoles Server. The User Guide contains the information required to install and use the Quest ActiveRoles Server. It is intended for network administrators, consultants, analysts, and any other IT professionals using the product.

Conventions

In order to help you get the most out of this guide, we have used specific formatting conventions. These conventions apply to procedures, icons, keystrokes and cross-references.

<table>
<thead>
<tr>
<th>ELEMENT</th>
<th>CONVENTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>This word refers to actions such as choosing or highlighting various interface elements, such as files and radio buttons.</td>
</tr>
<tr>
<td>Bolded text</td>
<td>Interface elements that appear in Quest Software products, such as menus and commands.</td>
</tr>
<tr>
<td>Italic text</td>
<td>Used for comments.</td>
</tr>
<tr>
<td>Bold Italic text</td>
<td>Used for emphasis.</td>
</tr>
<tr>
<td>Blue text</td>
<td>Indicates a cross-reference. When viewed in Adobe® Reader®, this format can be used as a hyperlink.</td>
</tr>
<tr>
<td>![Icon1]</td>
<td>Used to highlight additional information pertinent to the process being described.</td>
</tr>
<tr>
<td>![Icon2]</td>
<td>Used to provide Best Practice information. A best practice details the recommended course of action for the best result.</td>
</tr>
<tr>
<td>![Icon3]</td>
<td>Used to highlight processes that should be performed with care.</td>
</tr>
<tr>
<td>+</td>
<td>A plus sign between two keystrokes means that you must press them at the same time.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About Quest Software, Inc.

Quest Software, Inc., a two-time winner of Microsoft’s Global Independent Software Vendor Partner of the Year award, delivers innovative products that help organizations get more performance and productivity from their applications, databases Windows infrastructure and virtual environments. Through a deep expertise in IT operations and a continued focus on what works best, Quest helps more than 100,000 customers worldwide meet higher expectations for enterprise IT. Quest’s Windows management solutions simplify, automate secure and extend Active Directory, Exchange Server, SharePoint, SQL Server, .NET and Windows Server as well as integrating Unix, Linux and Java into the managed environment. Quest Software can be found in offices around the globe and at www.quest.com.

Contacting Quest Software

<table>
<thead>
<tr>
<th>Email</th>
<th><a href="mailto:info@quest.com">info@quest.com</a></th>
</tr>
</thead>
</table>
| Mail        | Quest Software, Inc.  
World Headquarters  
5 Polaris Way  
Aliso Viejo, CA  92656  
USA |
| Web site    | www.quest.com |

Refer to our Web site for regional and international office information.

Contacting Quest Support

Quest Support is available to customers who have a trial version of a Quest product or who have purchased a commercial version and have a valid maintenance contract. Quest Support provides around the clock coverage with SupportLink, our web self-service. Visit SupportLink at http://support.quest.com/

From SupportLink, you can do the following:

- Quickly find thousands of solutions (Knowledgebase articles/documents).
- Download patches and upgrades.
- Seek help from a Support engineer.
- Log and update your case, and check its status.

View the Global Support Guide for a detailed explanation of support programs, online services, contact information, and policy and procedures. The guide is available at http://support.quest.com/pdfs/Global Support Guide.pdf.

Note: This document is only available in English.
Introduction

Quest ActiveRoles Server is an administrative platform that facilitates administration and provisioning for Active Directory and Exchange. ActiveRoles Server enables the organization to develop a flexible administrative structure that suits their needs, while ensuring secure delegation of tasks, reduced workloads, and lower costs.

ActiveRoles Server increases the productivity of system administrators and help-desk operators by automating provisioning tasks on directory objects in compliance with corporate administrative policies in corporate Active Directory and Exchange environments. The policy enforcement featured in the product guarantees that every administrative action taken is consistent with corporate security standards, which is a top priority for most organizations.

The ActiveRoles Server User Guide is designed for individuals responsible for performing administrative tasks using the ActiveRoles Server console (MMC Interface). This document provides information about the ActiveRoles Server console user interface, and includes instructions to help delegated administrators and help-desk operators perform day-to-day administrative activities.

The ActiveRoles Server User Guide is supplemented with the ActiveRoles Server Administrator Guide that provides conceptual information about the product, and includes systematic instructions on how to deploy the ActiveRoles Server administrative structure.
Getting Started

- Starting the ActiveRoles Server Console
- User Interface Overview
- View Mode
- Using Managed Units
- Setting Up Filter
- Finding Objects
- Getting Policy-related Information
Starting the ActiveRoles Server Console

The ActiveRoles Server console, also referred to as MMC Interface, is a comprehensive administrative tool for managing Active Directory and Microsoft Exchange. With the ActiveRoles Server console, you can easily find directory objects and perform administrative tasks.

To start the ActiveRoles Server console

- Select Start | Programs | Quest Software | ActiveRoles Server, and then click ActiveRoles Server Console.

Normally, the ActiveRoles Server console automatically chooses the Administration Service and establishes a connection. If the console cannot connect to the Administration Service or you want to manually select the Administration Service, refer to the “Connecting to the Administration Service” section in the ActiveRoles Server Administrator Guide.

Getting and Using Help

ActiveRoles Server Help explains concepts and includes instructions for performing tasks with the product.

You can use the following guidelines to get assistance while you work:

- To access ActiveRoles Server Help, click Help on the Action menu or Help Topics on the Help menu.
- To view description of a dialog box, click the Help button in the dialog box or press F1.
- To view a brief description of a menu command or a toolbar button, point to the command or button. The description is displayed in the status bar at the bottom of the window.

This manual references Help topics by specifying topic paths in the structure shown on the Contents tab in the Help viewer. For example, to access the topic referenced as How To/Search for Objects you should expand the headings Quest ActiveRoles Server, How To in succession, and then click Search for Objects under How To.

You can print a single Help topic or all Help topics under a selected heading.

To print a single Help topic

1. On the menu bar, click Help and then click Help Topics.
2. In the left pane of the Help viewer, expand the heading that contains the topic you want to print, and then click the topic.
3. On the Help viewer toolbar, click Options, and then click Print.
4. Click OK to print only the selected topic.

To print all Help topics under a heading

1. On the menu bar, click Help, and then click Help Topics.
2. In the left pane of the Help viewer, click the heading that contains the topics you want to print.
3. On the Help viewer toolbar, click Options, and then click Print.
4. In the Print Topics dialog box, click Print the selected heading and all subtopics, and then click OK.
User Interface Overview

When started, the ActiveRoles Server console displays a window similar to the following.

The left pane contains the console tree, showing the items that are available in the snap-in. The right pane, known as the details pane, displays information about items you select in the console tree. You can perform most management tasks from this pane using commands on the Action menu.

Additional information is displayed in the lower sub-pane of the details pane when you check the Advanced Details Pane command on the View menu. You can perform management tasks from the lower sub-pane using commands on the Action menu.

Console Tree

The left pane of the ActiveRoles Server console contains the console tree.

The console tree root is labeled ActiveRoles Server. The name of the Administration Service is shown in square brackets. If you have Advanced view mode selected for ActiveRoles Server console display (View | Mode), the following folders are shown under the console tree root:

- **Configuration** Contains all ActiveRoles Server proprietary objects held in containers with appropriate names.
- **Active Directory** Contains a list of domains registered with ActiveRoles Server. In this folder, you can browse domains for directory objects (users, group, computers), and perform management tasks on those objects.
- **AD LDS (ADAM)** Contains a list of AD LDS directory partitions registered with ActiveRoles Server. In this folder, you can browse partitions for directory objects (users, group, containers), and perform management tasks on those objects.
- **Applications** Contains a list of applications integrated with ActiveRoles Server, such as Reporting, and allows for quick access to those applications.
The console display mode determines which folders are displayed in the console tree. For more information, see “View Mode” later in this document.

Details Pane

When you select an item in the console tree, the details pane changes accordingly. To perform administrative tasks, click items in the details pane and use commands on the Action menu. The Action menu commands also appear on the shortcut menu that you can access by right-clicking items in the console tree or details pane.

By default, the objects listed in the details pane are sorted in ascending order by object name. You can change the sorting order by clicking a column heading. You can add and remove columns in the details pane using the Choose Columns command on the View menu.

In the ActiveRoles Server console you can apply filters to the details pane in order to search for directory objects. To configure a filter, select a domain and then click Filter Options on the View menu. It is also possible to find an object in the details pane by typing a few characters. This will select the first item in the sorted column that matches what you typed.

Advanced Pane

The advanced pane appears at the bottom of the details pane if you check Advanced Details Pane on the View menu. You can use the advanced pane to administer an object selected in the console tree or details pane: right-click an existing entry in the list to administer it, or right-click a blank area of the advanced pane to add a new entry.

The advanced pane is composed of a number of tabbed pages. The selected object determines which tabs are displayed. All possible tabs in the advanced pane and their descriptions are as follows:

- **AR Server Security** Lists ActiveRoles Server Access Templates applied to the selected object.
- **Links** Lists the objects to which the selected Access Template is applied.
- **AR Server Policy** Lists ActiveRoles Server Policy Objects applied to the selected object.
- **Native Security** Lists Active Directory permission entries specified for the selected object.
- **Member Of** Lists groups to which the selected object belongs.
- **Members** Lists members of the selected group.

The ActiveRoles Server console displays the **AR Server Security**, **AR Server Policy**, and **Native Security** tabs for a selected object only if your user account has the Read Control right to the selected object.

Depending on the tab you have selected in the advanced pane, the toolbar displays the following buttons to help you work with the entries on the tab.
In the ActiveRoles Server console you can choose view mode—Basic, Advanced, or Raw. Changing view mode makes it possible to filter out advanced objects and containers from the display.

Basic mode displays Active Directory objects and Managed Units, and filters out objects and containers related to the ActiveRoles Server configuration. Basic mode should normally be used by delegated administrators and help-desk operators.

Advanced mode displays all objects and containers except those reserved for ActiveRoles Server internal use. Advanced mode is designed for administrators who are responsible for configuring the system and managing ActiveRoles Server proprietary objects.

Raw mode displays all objects and containers defined in the ActiveRoles Server namespace. This mode is primarily designed for troubleshooting.
With Raw mode, the console displays all data it receives from the Administration Service. With Basic or Advanced mode, some data is filtered out. For example, the **Configuration** folder is not shown in the console tree with Basic mode. Another example is the **Configuration Container** folder used to display the Active Directory configuration naming context, which is displayed with Raw mode only. In addition, there are some commands and property pages that are only displayed when the console is in Raw mode.

In short, when you choose Raw mode, the snap-in displays everything it is able to display. Otherwise, some items are hidden. Note that changing view mode does not modify any items. Rather, this only shows or hides particular items from the display.

To change view mode, click **Mode** on the **View** menu. In the **View Mode** dialog box, click **Basic Mode**, **Advanced Mode**, or **Raw Mode**.

### Controlled Objects

The ActiveRoles Server console provides for visual indication of objects where Access Template, Policy Objects, or Group Policy objects are applied. A green arrow on the normal icon of an object is used to mark those objects: 🟢

To mark objects, on the **View** menu, click **Mark Controlled Objects**. Select the check boxes to specify categories of objects to be marked, and click **OK**.

### Using Managed Units

ActiveRoles Server offers these key security and administration elements:

- **Trustees** Users or groups that have permissions to administer users, groups, computers, or other directory objects.
- **Permissions and Roles** Permissions are grouped in Access Templates (roles) to define how a Trustee can manage directory objects.
- **Managed Units** Collections of directory objects delegated to Trustees for administration.

The directory administrator defines which users or groups are designated as Trustees, which roles and permissions are assigned to Trustees, and what objects are included in Managed Units.
Managed Units are used to determine the directory objects that a Trustee can administer. As a Trustee, you can administer Managed Units for which you have assigned permissions. Managed Units containing objects you are authorized to administer are displayed under Managed Units in the console tree. Basic view mode displays Managed Units and their members, as shown in the following figure.

When you select a Managed Unit in the console tree, the details pane displays a list of objects included in that Managed Unit. To administer objects, select them from the list and use the commands on the Action menu.

If a Managed Unit includes a container, such as an Organizational Unit, the container is displayed under the Managed Unit in the console tree, as shown in the in the figure. When you select a container in the console tree, the details pane lists all child objects and sub-containers held in that container.
Setting Up Filter

The ActiveRoles Server console makes it possible to apply a filter to display only the objects that match the filtering criteria. To apply a filter, select an Active Directory object or container and click the Filter button on the toolbar:

This displays the Filter Options dialog box similar to that shown in the following figure.

After you set the filter, the filtering criteria immediately take effect on all lists of Active Directory objects in the ActiveRoles Server console.

For instructions on how to set up filter options, see How To/Change Views/Sort and filter lists in the details pane in ActiveRoles Server Help.

Finding Objects

In the ActiveRoles Server console you can search for objects of different types using the Find window. To access the Find window, right-click a container and click Find.

From the In list, you can select the container or Managed Unit you want to search. The list includes the container that you selected before activating the Find window. To add containers to the list, click Browse.
From the **Find** list, you can select the type of object you want to find, as shown in the following figure.

When you select an object type, the **Find** window changes accordingly. For example, **Users, Contacts, and Groups** searches for users, contacts, or groups using criteria such as user name, a note describing a contact, or the name of a group. In the **Find** list, ActiveRoles Server splits the **Users, Contacts, and Groups** category into three, providing the option for a more streamlined search.

By selecting **Custom Search** from the **Find** list, you can build custom search queries using advanced search options:

Using the **Find** window, you can search for any directory objects, such as users, groups, computers, Organizational Units, printers or shared folders. It is also possible to search for ActiveRoles Server configuration objects such as Access Templates, Managed Units, and Policy Objects. When you search for Access Templates, Policy Objects or Managed Units and select an appropriate object type from the **Find** list, the relevant container appears in the **In** list.

Once the search has completed, the objects matching the search criteria (search results) are listed at the bottom of the **Find** window. You can quickly find an object in the search results list by typing a few characters. This will select the first name that matches what you typed.
Once you have found the object, you can manage it by right-clicking the entry in the search results list, and then clicking commands on the shortcut menu.

For step-by-step instructions on how to perform a search, see **How To/Search for Objects** in ActiveRoles Server Help.

### Getting Policy-related Information

In object creation wizards and properties dialog boxes, some property labels may be displayed as hyperlinks. This indicates that ActiveRoles Server enforces policy restrictions on the property.

In the following figure, the **User logon name** and **User logon name (pre-Windows 2000)** labels are underlined, which means that these properties are under the control of a certain policy defined with ActiveRoles Server.

To examine the policy in detail, you can click the label. For example, if you click **User logon name (pre-Windows 2000)**, the ActiveRoles Server console presents you with a window similar to the following figure.
The window may display the following information:

- **Policy Description** Provides a brief description of the policy.
- **Message** Details the problem if the supplied property value violates the policy.

You can click arrows in the lower-left corner to display description of other policies enforced on the given property.

The **Message** section is displayed whenever the specified property value violates the policy. The following figure illustrates the situation where a value has not been supplied for a mandatory property.

When you click **Go To** in this window, the console moves the pointer to the field that needs to be corrected. You can type or select an appropriate value to correct your input.
User Account Management

- About User Accounts
- User Account Management Tasks
About User Accounts

User accounts allow users to log on to computers, and control their access to network resources. The operating system relies on the user account information to determine access permissions for the corresponding user.

ActiveRoles Server provides the facility to perform administrative tasks such as create, copy, rename, modify, and delete user accounts. It can also be used to unlock accounts, add and remove accounts from groups, and reset user passwords. ActiveRoles Server also supports Exchange tasks, such as create, delete, and move user mailboxes.

The following section guides you through the ActiveRoles Server console to manage user accounts. You can also perform these tasks using the ActiveRoles Server Web Interface.

User Account Management Tasks

This section covers the following tasks:

- Creating a user account
- Finding a user account
- Copying a user account
- Modifying user account properties
- Renaming a user account
- Disabling and enabling a user account
- Resetting user password
- Adding user accounts to groups
- Removing a user account from groups
- Changing a user’s primary group
- Performing Exchange tasks on a user account
- Moving user accounts
- Exporting and importing user accounts
- Deleting user accounts
Creating a User Account

You can create a user account as follows: in the console tree, right-click the container where you want to add the user account, select **New | User**, and then follow the instructions in the wizard.

In the wizard, some property labels may be displayed as hyperlinks. In the following figure, these are **Full name**, **Display name**, **User logon name** and **User logon name (pre-Windows 2000)**. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. The wizard cannot proceed until you enter an acceptable value.

For step-by-step instructions on how to create user accounts, see **How To/Manage User Accounts/Create a user account** in ActiveRoles Server Help.

Finding a User Account

To find a user account, right-click the container you want to search and click **Find**. In the **Find** window, select **Users** from the **Find** list, specify your search criteria, and start the search. In the search results list, you can right-click user accounts and use commands on the shortcut menu to perform management tasks. For more information, see “Finding Objects” earlier in this document.

For step-by-step instructions on how to search for user accounts, see **How To/Manage User Accounts/Find a user account** in ActiveRoles Server Help.
Copy Object - User

The copy of a user account belongs to the same Windows groups as that (original) user account.

For step-by-step instructions on how to copy a user account, see How To/Manage User Accounts/Copy a user account in ActiveRoles Server Help.
Modifying User Account Properties

To modify user account properties, right-click the account and click Properties. You can make changes to user account properties in the Properties dialog box, shown in the following figure.

In the Properties dialog box, some property labels may be displayed as hyperlinks. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. Property changes cannot be applied until you enter an acceptable value.

You can use the Properties dialog box to view or modify any property of the user account: go to the Object tab and click Advanced Properties. In the Advanced Properties window you can manage all properties, including those that cannot be accessed via the Properties dialog box itself.

You can also display the Advanced Properties window as follows: right-click the user account and select All Tasks | Advanced Properties.

In the console, you can select multiple user accounts, right-click the selection, click Properties, and then modify properties of all the selected accounts collectively via the Properties dialog box.

For step-by-step instructions on how to manage properties of user accounts, see How To/Manage User Accounts/Modify user account properties in ActiveRoles Server Help.
## Renaming a User Account

To rename a user account, right-click the account and click **Rename**. Type a new name and press ENTER. This displays the **Rename User** dialog box, shown in the following figure. In the **Rename User** dialog box, you can change the user’s first name, last name, display name, and logon name.

![Rename User dialog box](image)

In the **Rename User** dialog box, hyperlinks are used to indicate the properties controlled by ActiveRoles Server policies (see “Getting Policy-related Information” earlier in this document).

For step-by-step instructions on how to rename user accounts, see **How To/Manage User Accounts/Rename a user account** in ActiveRoles Server Help.

## Disabling and Enabling a User Account

A user account can be disabled as a security measure to prevent a particular user from logging on, instead of deleting the user account.

To disable a user account, right-click the account and click **Disable Account**. To enable a user account, right-click a disabled account and click **Enable Account**. The **Enable Account** command only appears on disabled accounts. Disabled user accounts are marked with the following icon: 🐌

For step-by-step instructions on how to disable and enable user accounts, see **How To/Manage User Accounts/Disable a user account** and **How To/Manage User Accounts/Enable a disabled user account** in ActiveRoles Server Help.
Reseting User Password

To reset the password for a user account, right-click the account and click Reset Password. This displays the Reset Password dialog box, shown in the following figure. In the Reset Password dialog box, it is possible to generate passwords, set password options, and unlock the account if it is locked out. To generate a password, click the button next to the New Password box.

![Reset Password Dialog Box](image)

For step-by-step instructions on how to reset a password, see How To/Manage User Accounts/Reset a user password in ActiveRoles Server Help.

Adding User Accounts to Groups

To add user accounts to groups, select the accounts, right-click the selection, and click Add to a group. This displays the Select Objects dialog box where you can select the groups to which you want to add the accounts.

In the Select Objects dialog box, you can select groups from the list or type group names, separating them with semicolons. Use the Check Names button to verify the names you type. If ActiveRoles Server cannot find a group, it prompts you to correct the name, as shown in the following figure.
You can also add a user account to groups by modifying the group membership list on the **Member Of** tab in the **Properties** dialog box. To display the **Properties** dialog box, right-click the user account and click **Properties**.

The **Member Of** tab lists the groups to which the account belongs, as shown in the following figure. If the **Show nested groups** check box is selected, the list also includes the groups to which the account belongs owing to group nesting.

The **Temporal Membership Settings** button can be used to specify the date and time when the user should be added or removed from the selected groups. For more information about this feature, see “Using Temporal Group Memberships” later in this document.

On the **Member Of** tab, you can manage groups directly from the list of groups. To manage a group, right-click it, and use commands on the shortcut menu.

You can add the user account to groups by clicking **Add** on the **Member Of** tab. This displays the **Select Objects** dialog box, allowing you to select the groups to which you want to add the user account.

When you select multiple user accounts, the **Member Of** tab lists the groups to which all the selected accounts belong. If one of the accounts does not belong to a given group, that group does not appear in the list.

For step-by-step instructions on how to add users to a group, see **How To/Manage User Accounts/Add a user account to a group** in ActiveRoles Server Help.
Removing a User Account from Groups

To remove a user account from groups, right-click the user account, click Properties, and go to the Member Of tab. On the Member Of tab, select groups from the list and click Remove.

For step-by-step instructions on how to remove users from a group, see How To/Manage User Accounts/Remove a user account from a group in ActiveRoles Server Help.

Changing a User’s Primary Group

The user’s primary group applies only to users who log on to the network through Services for Macintosh, or to users who run POSIX-compliant applications. If you are not using these services, there is no need to change the primary group from Domain Users, which is the default setting.

To change a user’s primary group, right-click the account, click Properties, and go to the Member Of tab. On the Member Of tab, select a group from the list and click the Set Primary Group button.

Note that only a global or universal security group can be set as the primary group. If you select a group with group scope set to Domain local, or a distribution group, the Set Primary Group button is unavailable.

For step-by-step instructions on how to change a user’s primary group, see How To/Manage User Accounts/Change a user’s primary group in ActiveRoles Server Help.

Performing Exchange Tasks on a User Account

To perform Exchange tasks on a user account, right-click the account, click Exchange Tasks, and follow the instructions in the Exchange Task Wizard.

The Exchange Task Wizard helps you manage Exchange 200x recipients by providing a set of tasks that apply to the selected account. The list of tasks looks similar to that shown in the following figure.
For more information, see “Exchange Tasks on User Accounts” later in this document.

For step-by-step instructions on how to perform Exchange tasks on user accounts, see How To/Manage User Accounts/Perform Exchange tasks in ActiveRoles Server Help.

Moving User Accounts

To move user accounts to another container, select the accounts, right-click the selection, and then click Move. In the Move dialog box, select the container to which you want to move the accounts.

Microsoft Management Console version 2.0 or later provides the drag-and-drop function for moving objects. To move user accounts, you can drag the selection from the details pane to a destination container in the console tree.

For step-by-step instructions on how to move user accounts between directory folders, see How To/Manage User Accounts/Move a user account in ActiveRoles Server Help.

Exporting and Importing User Accounts

With the ActiveRoles Server console, you can export user accounts to an XML file and then import them from that file to populate a container in a different domain. The export and import operations provide a way to relocate user accounts between domains.

To export user accounts, select them, right-click the selection, and select All Tasks | Export. In the Export Objects dialog box, specify the file where you want to save the data, and click Save.

To import user accounts, right-click the container where you want to place the accounts, and then click Import. In the Import Directory Objects dialog box, select the file to which the user accounts were exported, and click Open.

For step-by-step instructions on how to export and import user accounts, see How To/Manage User Accounts/Export a user account and How To/Manage User Accounts/Import a user account in ActiveRoles Server Help.

Deleting User Accounts

To delete user accounts, select them, right-click the selection, and click Delete. Then, click Yes to confirm the deletion. If you select multiple user accounts, clicking Delete displays the Delete Objects dialog box. To delete all the selected accounts, select the Apply to all items check box, and then click Yes.

Deleting a user account is an irreversible operation. A new user account with the same name as a deleted user account does not automatically assume the permissions and memberships of the deleted account. For this reason, it is advisable to disable rather than delete accounts.

For step-by-step instructions on how to delete user accounts, see How To/Manage User Accounts/Move a user account in ActiveRoles Server Help.
Group Management

- About Groups
- Group Management Tasks
- Using Temporal Group Memberships
About Groups

Groups are Active Directory objects used to collect users, contacts, computers, and other groups into manageable units. There are three kinds of groups:

- **Security groups** Used to manage user and computer access to shared network resources. When assigning permissions to access resources, administrators assign permissions to security groups rather than to individual users.
- **Distribution groups** Used as e-mail distribution lists. Distribution groups have no security function.
- **Query-Based Distribution groups** Used also as e-mail distribution lists but the difference is that members of such a group are not specified statically. Membership of these groups is built in dynamic manner using LDAP queries.

In this document, security and distribution groups are collectively referred to as *groups*. As for Query-based distribution groups, these are considered a separate category of groups.

Each group has a scope: universal, global, or domain local.

- **Universal** groups can include groups and accounts from any domain in the domain tree or forest, and can be granted permissions in any domain in the domain tree or forest.
- **Global** groups can only include groups and accounts from the domain in which the group is defined. Global groups can be granted permissions in any domain in the forest.
- **Domain local** groups can include groups and accounts from other domains. These groups can only be granted permissions within the domain in which the group is defined.

A group can be a member of another group. This is referred to as *group nesting*. Group nesting increases the number of affected member accounts and thus consolidates group management. Accounts that reside in a group nested within another group are indirect members of the nesting group.

ActiveRoles Server provides the facility to perform administrative tasks such as create copy, rename, modify, and delete groups. It can also be used to add and remove members from groups and perform Exchange tasks on groups.

The following section describes how to use the ActiveRoles Server console to manage groups. You can also use the ActiveRoles Server Web Interface to perform group management tasks.

Group Management Tasks

This section covers the following tasks:

- Creating a group
- Finding a group
- Copying a group
- Modifying group properties
- Changing group type and group scope
- Renaming a group
- Assigning a manager over a group
- Adding members to a group
• Removing members from a group  
• Performing Exchange tasks on a group  
• Moving groups  
• Exporting and importing groups  
• Deleting groups  
• Administering query-based distribution groups  
• Administering dynamic (rules-based) groups  
• Publishing a group to Self-Service Manager

Creating a Group

You can create a group as follows: in the console tree, right-click the container where you want to add the group, select New | Group, and then follow the instructions in the wizard.

In the wizard, some property labels may be displayed as hyperlinks. In the following figure, these are Group name and Group name (pre-Windows 2000). The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see "Getting Policy-related Information" earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. The wizard cannot proceed until you enter an acceptable value.

For step-by-step instructions on how to create groups, see How To/Manage Groups/Create a group in ActiveRoles Server Help.
**Finding a Group**

To find a group, right-click the container you want to search, and click **Find**. In the **Find** window, select **Groups** from the **Find** list, specify your search criteria, and start the search. In the search results list, you can right-click groups and use commands on the shortcut menu to perform management tasks. For more information, see “Finding Objects” earlier in this document.

For step-by-step instructions on how to search for groups, see **How To/Manage Groups/Find a group** in ActiveRoles Server Help.

**Copying a Group**

To create a copy of a group, right-click the group, click **Copy**, and follow the instructions in the wizard. The first step of the wizard looks as shown in the following figure.

![Copy Object - Group](image)

The copy contains the same permission settings as the original group. The Copy Object - Group wizard allows you to modify the membership list of the new group.

While copying a group, the ActiveRoles Server console does not allow you to change the group scope or the group type.

For step-by-step instructions on how to copy a group, see **How To/Manage Groups/Copy a group** in ActiveRoles Server Help.
Modifying Group Properties

To modify group properties, right-click the group and click Properties. You can make changes to group properties using the Properties dialog box, shown in the following figure.

In the Properties dialog box, some property labels may be displayed as hyperlinks. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see "Getting Policy-related Information" earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. Property changes cannot be applied until you enter an acceptable value.

You can use the Properties dialog box to view or modify any property of the group: go to the Object tab and click Advanced Properties. In the Advanced Properties window you can manage all properties, including those that cannot be accessed via the Properties dialog box itself.

You can also display the Advanced Properties window as follows: right-click the group and select All Tasks | Advanced Properties.

In the console, you can select multiple groups, right-click the selection, click Properties, and then modify properties of all the selected groups collectively via the Properties dialog box.

For step-by-step instructions on how to manage group properties, see How To/Manage Groups/Modify group properties in ActiveRoles Server Help.
Changing Group Type and Group Scope

Group type can be changed from Security to Distribution, and vice versa, if there are no pre-Windows 2000 domain controllers in the domain (native-mode domain).

It is forbidden to change group scope in a domain with pre-Windows 2000 domain controllers (mixed-mode domain). The following conversions are allowed in a native-mode domain:

- **Global to Universal** Only allowed if the group being converted is not a member of another group with global scope.
- **Domain Local to Universal** Only allowed if the group being converted does not contain a member that is itself another group with domain local scope.

To change group scope or group type, right-click the group, click Properties, and go to the General tab in the Properties dialog box, shown in the following figure. On the General tab, click the group type in the Group type area or click the group scope under Group scope.

For step-by-step instructions on how to convert groups to another type, see How To/Manage Groups/Convert a group to another group type in ActiveRoles Server Help.

For step-by-step instructions on how to change group scope, see How To/Manage Groups/Change group scope in ActiveRoles Server Help.
Renaming a Group

To rename a group, right-click the group, and then click Rename. Type a new name and press ENTER. This displays the Rename Group dialog box, shown in the following figure. In the Rename Group dialog box, you can change the group name and group name (pre-Windows 2000).

![Rename Group dialog box](image)

In the Rename Group dialog box, hyperlinks are used to indicate the properties controlled by ActiveRoles Server policies (see "Getting Policy-related Information" earlier in this document).

For step-by-step instructions on how to rename groups, see How To/Manage Groups/Rename a group in ActiveRoles Server Help.
Assigning a Manager over a Group

To assign a manager over a group, right-click the group, click Properties, and go to the Managed By tab in the Properties dialog box, shown in the following figure. On the Managed By tab, click Change and select the user or contact to designate as the manager.

If you select Manager can update membership list, the manager can use ActiveRoles Server to add and remove members from the group.

It is possible to assign multiple group owners, to load balance the management of the group. To assign additional owners to the group, click the button next to the Secondary owners box. Group owners can be given the same rights over the group as the manager. For example, selecting the check box beneath the Secondary owners box gives the secondary owners the authority to add or remove members from the group.

It is possible to assign management of the group to another group: you can select a group in the Select Objects dialog box that you use to specify the manager or a secondary owner. This enables every member of the group to act as the manager or secondary owner.

For step-by-step instructions on how to assign a manager over a group, see How To/Manage Groups/Assign a manager over a group in ActiveRoles Server Help.
Adding Members to a Group

Depending on its scope, a group may contain members (users, groups, computers, contacts) from anywhere in the forest, or only members from its own domain.

To add members to a group, right-click the group, click Properties, and go to the Members tab in the Properties dialog box. On the Members tab, click Add. This displays the Select Objects dialog box where you can select the objects you want to add to the group.

In the Select Objects dialog box, you can select objects from the list or type object names. Use the Check Names button to verify the names you type. If ActiveRoles Server cannot find an object, it prompts you to correct the name.

The Members tab lists objects that belong to the group. If the Show indirect members check box is selected, the list also includes the objects that belong to the group because of group nesting.

The Temporal Membership Settings button can be used to specify the date and time when the selected members should be added or removed from the group. For more information about this feature, see “Using Temporal Group Memberships” later in this document.

On the Members tab, you can manage user accounts and other objects directly from the list of members. To manage a group member, right-click the member and use commands on the shortcut menu.

When you select multiple groups, the Members tab lists the objects that belong to each of the selected groups. If a given object does not belong to one of the selected groups, then that object does not appear in the list.

For step-by-step instructions on how to add members to groups, see How To/Manage Groups/Add a member to a group in ActiveRoles Server Help.
Removing Members from a Group

To remove members from a group, right-click the group, click Properties, and go to the Members tab in the Properties dialog box. On the Members tab, select members from the list and click Remove.

For step-by-step instructions on how to remove members from groups, see How To/Manage Groups/Remove a member from a group in ActiveRoles Server Help.

Performing Exchange Tasks on a Group

To perform Exchange tasks on a group, right-click the group, click Exchange Tasks, and follow the instructions in the Exchange Task Wizard.

The Exchange Task Wizard helps you manage Exchange 200x recipients by providing a set of tasks that apply to the selected group. The list of tasks looks similar to that shown in the following figure.

For more information, see “Exchange Tasks on Groups” later in this document.

For step-by-step instructions on how to perform exchange tasks on groups, see How To/Manage Groups/Perform Exchange tasks in ActiveRoles Server Help.

Moving Groups

To move groups to another container, select the groups, right-click the selection, and click Move. In the Move dialog box, select the container to which you want to move the groups.

Microsoft Management Console version 2.0 or later provides the drag-and-drop function for moving objects. To move a group, you can drag it from the details pane to a destination container in the console tree.

For step-by-step instructions on how to move groups between directory folders, see How To/Manage Groups/Move a group in ActiveRoles Server Help.
Exporting and Importing Groups

With the ActiveRoles Server console, you can export groups to an XML file and then import them from that file to populate a container in a different domain. The export and import operations provide a way to relocate groups between domains.

To export groups, select them, right-click the selection, and select All Tasks | Export. In the Export Objects dialog box, specify the file where you want to save the data, and click Save.

To import groups, right-click the container where you want to place the groups, and then click Import. In the Import Directory Objects dialog box, select the file to which the groups were exported, and click Open.

For step-by-step instructions on how to export and import a group, see How To/Manage Groups/Export a group and How To/Manage Groups/Import a group in ActiveRoles Server Help.

Deleting Groups

To delete groups, select them, right-click the selection, and click Delete. Then, click Yes to confirm the deletion. If you select multiple groups, clicking Delete displays the Delete Objects dialog box. To delete all the selected groups, select the Apply to all items check box, and then click Yes.

Deleting a group is an irreversible operation. A new group with the same name as a deleted group does not automatically assume the permissions and memberships of the deleted group. When recreating a deleted group, you need to manually add all permissions and memberships.

For step-by-step instructions on how to delete groups, see How To/Manage Groups/Delete a group in ActiveRoles Server Help.
Administering Query-based Distribution Groups

Query-based distribution group is type of distribution group that is introduced in Exchange Server 2003. The difference from the usual distribution group is that members of a query-based group are not statically placed into it. E-mail is propagated among the members of the group, but only among those of them who is currently in the state to comply with the specified LDAP query of this distribution group.

You can create a query-based distribution group as follows: in the console tree, right-click the container where you want to add the group, select **New | Query-based Distribution Group**, and then follow the instructions in the wizard. The following figure shows the step of the wizard where you can set up a query.

![New Object - Query-based Distribution group](image)

On this page, you can choose between predefined filters and custom filter. If select **Custom filter**, click **Customize** to configure the filter. This displays the **Custom Search** window where you can specify your search criteria.

You can manage a query-based distribution group in much the same way as you do with regular distribution groups: right-click the group and then select a command on the shortcut menu.

For step-by-step instructions on how to manage query based distribution groups, see **How To/Manage Groups/Managing a query-based distribution group** in ActiveRoles Server Help.

Administering Dynamic (Rules-based) Groups

ActiveRoles Server provides the capability to automatically keep group membership lists up to date, eliminating the need to add and remove members manually. To automate the maintenance of group membership lists, ActiveRoles Server employs the following features:

- Rules-based mechanism that automatically adds and removes objects to groups whenever object attributes change in Active Directory.
- Flexible membership criteria that enable both query-based and static population of groups.
In ActiveRoles Server, rules-based groups are referred to as *dynamic groups*. The groups that have no membership rules specified are referred to as *basic groups*. Any security or distribution group can be converted to dynamic group by adding membership rules.

You can create a dynamic group by managing a basic group as follows: right-click the group, click **Convert to Dynamic Group**, select a rule type, and then configure a rule. For step-by-step instructions, see **How To/Manage Groups/Add a membership rule to a group** in ActiveRoles Server Help.

In the ActiveRoles Server console, dynamic groups are marked with this icon: 🛡️

When you convert a basic group to a dynamic group, the group loses all members that were added to the group when it was basic. This is because the membership list of a dynamic group is entirely under the control of membership rules.

Once membership rules are added to a group, the group only includes the objects that comply with the membership rules. ActiveRoles Server overrides any changes made directly to the membership list by any administrative tool.

A special note on the **General** tab makes it possible to distinguish between dynamic groups and basic groups when using administrative tools other than ActiveRoles Server.

For dynamic groups, the **Properties** dialog box includes the **Membership Rules** tab, as shown in the following figure. You can use this tab to examine, add, modify, or remove membership rules.

The **Members** tab for a dynamic group cannot be used to manage the membership list. It is only used to display a list of group members.
You can return a dynamic group to basic state as follows: right-click the group and click **Convert to Basic Group**. Then, click **Yes** to confirm the conversion. This operation removes all membership rules from the group. The group membership list remains intact as of the time of the conversion.

For more information about dynamic groups, refer to the "Dynamic Groups Management" section in the *ActiveRoles Server Administrator Guide*.

**Publishing a Group to Self-Service Manager**

You can publish a group to provide end-users with controlled access to their group memberships through the Self-Service Manager Web Interface. Publishing a group makes the group joinable by other people based on owner approval. Self-Service Manager enables users to submit requests to join or leave published groups, while ensuring that requests are granted only after approval by group owners.

To publish a group to Self-Service Manager, right-click the group and click **Publish**. This displays a dialog box where you can view or change the group description, keywords and notes, as well as specify who you want to approve changes to the group:

![Publish Group to Self-Service Manager dialog box](image)

Review and, if necessary, change the settings on the **Publish Group to Self-Service Manager** dialog box, and then click the **Publish** button to start the Publish operation.

This dialog box allows you to view, change, or configure the following settings:

- **Description** Review or change the text describing the group. This text helps users distinguish the group in the Self-Service Web Interface.

- **Keywords** These are words or phrases most likely to describe the group to someone looking for it. The keywords assigned to a group help users find the group in the Self-Service Web Interface. Click the button next to the **Keywords** box to add, change, or remove keywords.

- **Notes** Review or change the comment text on the group. This text helps distinguish the group in address lists displayed by e-mail clients, such as Microsoft Outlook.
Two other options on this dialog box are used to specify whether any approval decisions are required when users attempt to add or remove themselves from the group using ActiveRoles Server:

- **Approval by the primary owner (manager) of the group** When this check box is selected, ActiveRoles Server adds or removes a group member only after this is approved by the manager of the group. You can view or change the manager setting on the Managed By tab in the Properties dialog box for the group.

- **Approval by a secondary owner of the group** When this check box is selected, ActiveRoles Server adds or removes a member only after this is approved by one of the secondary owners of the group. You can view or change the list of secondary owners on the Managed By tab in the Properties dialog box for the group.

With any of these options selected, ActiveRoles Server starts an approval workflow upon a request to add or remove a member from the group. The approval workflow is configured so that the request is stalled until the requested changes are approved.

When a group is published, the Unpublish command appears on the menu instead of the Publish command. By using the Unpublish command, you can stop publishing the group in Self-Service Manager.

The Properties dialog box for a group includes the Publish tab where you can see whether the group is published to Self-Service Manager:

![Properties dialog box](image)

From this tab you can publish or un-publish the group by selecting or clearing the check box. It is also possible to view or change approval options, which are the same as those in the Publish Group to Self-Service Manager dialog box.
Using Temporal Group Memberships

By using temporal group memberships, you can manage group memberships of objects such as user or computer accounts that need to be members of particular groups for only a certain time period. This feature of ActiveRoles Server gives you flexibility in deciding and tracking what objects need group memberships and for how long.

This section guides you through the tasks of managing temporal group memberships in the ActiveRoles Server console. If you are authorized to view and modify group membership lists, then you can add, view and remove temporal group members as well as view and modify temporal membership settings on group members.

Adding Temporal Members

A temporal member of a group is an object, such as a user, computer or group, scheduled to be added or removed from the group. You can add and configure temporal members using the ActiveRoles Server console.

To add temporal members of a group

1. In the ActiveRoles Server console, right-click the group and click Properties.
2. On the Members tab in the Properties dialog box, click Add.
3. In the Select Objects dialog box, click Temporal Membership Settings.
4. In the Temporal Membership Settings dialog box, choose the appropriate options, and then click OK:
   - To have the temporal members added to the group on a certain date in the future, select On this date under Add to the group, and choose the date and time you want.
   - To have the temporal members added to the group at once, select Now under Add to the group.
   - To have the temporal members removed from the group on a certain date, select On this date under Remove from the group, and choose the date and time you want.
   - To retain the temporal members in the group for indefinite time, select Never under Remove from the group.
5. In the Select Objects dialog box, type or select the names of the objects you want to make temporal members of the group, and click OK.
6. Click Apply in the Properties dialog box for the group.

   • To add temporal members of a group, you must be delegated the authority to add or remove members from the group. The appropriate authority can be delegated by applying the Groups - Add/Remove Members Access Template.
   • You can make an object a temporal member of particular groups by managing properties of the object rather than properties of the groups. Open the Properties dialog box for that object, and then, on the Member Of tab, click Add. In the Select Objects dialog box, specify the temporal membership settings and supply the names of the groups as appropriate for your situation.
Viewing Temporal Members

The list of group members displayed by the ActiveRoles Server console makes it possible to distinguish between regular group members and temporal group members. It is also possible to hide or display so-called pending members, the temporal members that are scheduled to be added to the group in the future but are not actual members of the group so far.

To view temporal members of a group

1. In the ActiveRoles Server console, right-click the group and click Properties.
2. Examine the list on the Members tab in the Properties dialog box:
   • An icon of a small clock overlays the icon for the temporal members.
   • If the Show pending members check box is selected, the list also includes the temporal members that are not yet added to the group. The icons identifying such members are shown in orange.

The list of group memberships for a particular object makes it possible to distinguish between the groups in which the object is a regular member and the groups in which the object is a temporal member. It is also possible to hide or display so-called pending group memberships, the groups to which the object is scheduled to be added in the future.

To view groups in which an object is a temporal member

1. In the ActiveRoles Server console, right-click the object and click Properties.
2. Examine the list on the Member Of tab in the Properties dialog box:
   • An icon of a small clock overlays the icon for the groups in which the object is a temporal member.
   • If the Show pending group memberships check box is selected, the list also includes the groups to which the object is scheduled to be added in the future. The icons identifying such groups are shown in orange.

Rescheduling Temporal Group Memberships

The temporal membership settings on a group member include the start time and end time settings.

The start time setting specifies when the object is to be actually added to the group. This can be specific date and time or an indication that the object should be added to the group right away.

The end time setting specifies when the object is to be removed from the group. This can be specific date and time or an indication that the object should not be removed from the group.

You can view or modify both the start time and end time settings using the ActiveRoles Server console.

To view or modify the start or end time setting for a member of a group

1. In the ActiveRoles Server console, right-click the group and click Properties.
2. In the list on the Members tab in the Properties dialog box, click the member and then click the Temporal Membership Settings button.
3. Use the Temporal Membership Settings dialog box to view or modify the start or end time settings.
The **Temporal Membership Settings** dialog box provides the following options:

- **Add to the group | Now** Indicates that the object should be added to the group at once.
- **Add to the group | On this date** Indicates the date and time when the object should be added to the group.
- **Remove from the group | Never** Indicates that the object should not be removed from the group.
- **Remove from the group | On this date** Indicates the date and time when the object should be removed from the group.

Regular members have the **Add to group** and **Remove from group** options set to **Already added** and **Never**, respectively. You can set a particular date for any of these options in order to convert a regular member to a temporal member.

- You can view or modify the start time and end time settings by managing an object rather than groups in which the object has memberships. Open the **Properties** dialog box for that object, and then, on the **Member Of** tab, select the group for which you want to manage the object’s start or end time setting and click **Temporal Membership Settings**.
- On the **Members** or **Member Of** tab, you can change the start or end time setting for multiple members or groups at a time. From the list on the tab, select two or more items and click **Temporal Membership Settings**. Then, in the **Temporal Membership Settings** dialog box, select check boxes to indicate the settings to change and make the changes you want.

### Removing Temporal Members

You can remove temporal group members in the same way as regular group members. Removing a temporal member of a group deletes the temporal membership settings for that object with respect to that group. As a result, the object will not be added to the group. If the object already belongs to the group at the time of removal, then it is removed from the group.

**To remove a temporal member of a group**

1. In the ActiveRoles Server console, right-click the group, and then click **Properties**.
2. On the **Members** tab in the **Properties** dialog box, click the member, click **Remove**, and then click **Apply**.

You can remove an object that is a temporal member of a group by managing the object rather than the group. Open the **Properties** dialog box for that object, and then, on the **Member Of** tab, select the group from the list and click **Remove**.
Computer Account Management

• About Computer Accounts
• Computer Account Management Tasks
About Computer Accounts

Computer accounts are Active Directory objects used to represent physical computers. Computer accounts allow computers to join the domain, and control their access to resources on the network. The operating system uses computer account information to determine access permissions for a computer.

ActiveRoles Server provides the facility to perform administrative tasks such as create, modify, and delete computer accounts. ActiveRoles Server can also be used to disable and enable accounts, add and remove accounts from groups, and reset accounts.

The following section describes how to use the ActiveRoles Server console to manage computer accounts. You can also use the ActiveRoles Server Web Interface to perform management tasks on computer accounts.

Computer Account Management Tasks

This section covers the following tasks:

- Creating a computer account
- Finding a computer account
- Modifying computer account properties
- Disabling and enabling a computer account
- Resetting a computer account
- Adding computer accounts to groups
- Removing a computer account from groups
- Moving computer accounts
- Exporting and importing computer accounts
- Deleting computer accounts
Creating a Computer Account

You can create a computer account as follows: in the console tree, right-click the container where you want to add the account, select **New | Computer**, and then follow the instructions in the wizard.

In the wizard, some property labels may be displayed as hyperlinks. In the following figure, these are **Computer name** and the **Computer name (pre-Windows 2000)**. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. The wizard cannot proceed until you enter an acceptable value.

For step-by-step instructions on how to create computer accounts, see **How To/Manage Computer Accounts/Create a computer account** in ActiveRoles Server Help.

Finding a Computer Account

To find a computer account, right-click the container you want to search and click **Find**. In the **Find** window, select **Computers** from the **Find** list, specify your search criteria, and start the search. In the search results list, you can right-click computer accounts and use commands on the shortcut menu to perform management tasks. For more information, see “Finding Objects” earlier in this document.

For step-by-step instructions on how to search for computer accounts, see **How To/Manage Computer Accounts/Find a computer account** in ActiveRoles Server Help.
Modifying Computer Account Properties

To modify computer account properties, right-click the account, and then click **Properties**. You can make changes to computer account properties in the **Properties** dialog box, shown in the following figure.

In the **Properties** dialog box, some property labels may be displayed as hyperlinks. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see "Getting Policy-related Information" earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. Property changes cannot be applied until you enter an acceptable value.

You can use the **Properties** dialog box to view or modify any property of the computer account: go to the **Object** tab and click **Advanced Properties**. In the **Advanced Properties** window you can manage all properties, including those that cannot be accessed via the **Properties** dialog box itself.

You can also display the **Advanced Properties** window as follows: right-click the computer account and select **All Tasks | Advanced Properties**.

In the console, you can select multiple computer accounts, right-click the selection, click **Properties**, and then modify properties of all the selected accounts collectively via the **Properties** dialog box.

For step-by-step instructions on how to manage computer account properties, see **How To/Manage Computer Accounts/Modify computer account properties** in ActiveRoles Server Help.
Disabling and Enabling a Computer Account

A computer account can be disabled as a security measure to prevent users from logging on to the computer, instead of deleting the computer account.

To disable a computer account, right-click the account and click **Disable Account**. To enable a computer account, right-click the account and click **Enable Account**. The **Enable Account** command only appears on disabled accounts. Disabled computer accounts are marked with the following icon: 🗝️.

For step-by-step instructions on how to disable and enable computer accounts, see **How To/Manage Computer Accounts/Disable a computer account** and **How To/Manage Computer Accounts/Enable a disabled computer account** in ActiveRoles Server Help.

Resetting a Computer Account

A computer account is normally reset if the computer has been taken offline and completely reinstalled. Resetting the account allows the (rebuilt) computer to rejoin the domain using the same name. If the computer account is reset whenever the computer has not been reinstalled, the computer cannot authenticate in the domain.

To reset a computer account, right-click the account, and click **Reset Account**. This command resets the computer account password. The **Reset Account** command is not available on domain controller accounts: resetting the password for domain controllers using this method is not allowed.

Adding Computer Accounts to Groups

Adding a computer account to a group enables you to assign permissions to all computer accounts in the group, and to filter Group Policy settings on all accounts in the group.

To add computer accounts to groups, select the accounts, right-click the selection, and click **Add to a Group**. This displays the **Select Objects** dialog box where you can select the groups to which you want to add the accounts (see “Adding User Accounts to Groups” earlier in this document).

You can also add a computer account to groups by modifying the group membership list on the **Member Of** tab in the **Properties** dialog box. To display the **Properties** dialog box, right-click the computer account and click **Properties**.
The **Member Of** tab lists the groups to which the computer account belongs, as shown in the following figure. If the **Show nested groups** check box is selected, the list also includes the groups to which the computer account belongs because of group nesting.

The **Temporal Membership Settings** button can be used to specify the date and time when the computer should be added or removed from the selected groups. For more information about this feature, see “Using Temporal Group Memberships” earlier in this document.

On the **Member Of** tab, you can manage groups directly from the list of groups: right-click a group and use commands on the shortcut menu.

You can add the computer account to groups by clicking **Add** on the **Member Of** tab. This displays the **Select Objects** dialog box, allowing you to select the groups to which you want to add the computer account.

When you select multiple computer accounts, the **Member Of** tab lists the groups to which all the selected accounts belong. If one of the accounts does not belong to a given group, that group does not appear in the list.

For step-by-step instructions on how to add computer accounts to groups, see **How To/Manage Computer Accounts/Add a computer account to a group** in ActiveRoles Server Help.

### Removing a Computer Account from Groups

To remove a computer account from groups, right-click the account, click **Properties**, and go to the **Member Of** tab. On the **Member Of** tab, select groups from the list and click **Remove**.

For step-by-step instructions on how to remove computer accounts from a group, see **How To/Manage Computer Accounts/Remove a computer account from a group** in ActiveRoles Server Help.
**Moving Computer Accounts**

To move computer accounts to another container, select the accounts, right-click the selection, and then click **Move**. In the **Move** dialog box, select the container to which you want to move the accounts.

Microsoft Management Console version 2.0 or later provides the drag-and-drop function for moving objects. To move computer accounts, you can drag the selection from the details pane to a destination container in the console tree.

For step-by-step instructions on how to move computer accounts, see **How To/Manage Computer Accounts/Move a computer account** in ActiveRoles Server Help.

**Exporting and Importing Computer Accounts**

With the ActiveRoles Server console, you can export computer accounts to an XML file and then import them from that file to populate a container in a different domain. The export and import operations provide a way to relocate computer accounts between domains.

To export computer accounts, select them, right-click the selection, and select **All Tasks | Export**. In the **Export Objects** dialog box, specify the file where you want to save the data, and click **Save**.

To import computer accounts, right-click the container where you want to place the accounts, and then click **Import**. In the **Import Directory Objects** dialog box, select the file to which the computer accounts were exported, and click **Open**.

For step-by-step instructions on how to export and import user accounts, see **How To/Manage Computer Accounts/Export a computer account** and **How To/Manage Computer Accounts/Import a computer account** in ActiveRoles Server Help.

**Deleting Computer Accounts**

To delete computer accounts, select them, right-click the selection, and click **Delete**. Then, click **Yes** to confirm the deletion. If you select multiple accounts, clicking **Delete** displays the **Delete Objects** dialog box. To delete all the selected accounts, select the **Apply to all items** check box, and then click **Yes**.

Deleting a computer account is an irreversible operation. A new computer account with the same name as a deleted account cannot authenticate in the domain unless the administrator re-joins the computer to the domain. For this reason, it is recommended that you disable rather than delete computer accounts.

For step-by-step instructions on how to delete computer accounts, see **How To/Manage Computer Accounts/Delete a computer account** in ActiveRoles Server Help.
Organizational Unit Management

- About Organizational Units
- Organizational Unit Management Tasks
About Organizational Units

Organizational Units (OUs) are containers in Active Directory. OUs can contain user accounts, groups, computer accounts, and other OUs. An object can be included in only one OU.

When you expand the Active Directory node in the ActiveRoles Server console, the console tree displays icons representing domains. You can double-click a domain icon to see containers that are defined in the domain. OUs are marked with the following icon: 🗂️

When you select an OU in the console tree, the details pane lists objects included in the OU, and the Action menu provides commands to create new objects in the OU, search for objects in the OU, and manage OU properties.

The following section guides you through the ActiveRoles Server console to manage Organizational Units. You can also use the ActiveRoles Server Web Interface to perform management tasks on Organizational Units.

Organizational Unit Management Tasks

This section covers the following tasks:
- Creating an Organizational Unit
- Finding an Organizational Unit
- Modifying Organizational Unit properties
- Renaming an Organizational Unit
- Moving an Organizational Unit
- Deleting an Organizational Unit

Creating an Organizational Unit

You can create an OU as follows: in the console tree, right-click the domain or another OU, select New Organizational Unit, and then follow the instructions in the wizard. The first page of the wizard looks as shown in the following figure.

Type the name for the new OU in the Name box and click Next. Then, click Finish to complete the operation.

For step-by-step instructions on how to create Organizational Units, see How To/Manage Organizational Units/Create an Organizational Unit in ActiveRoles Server Help.
Finding an Organizational Unit

To find an Organizational Unit, select the domain you want to search, and click Find. In the Find window, select Organizational Units from the Find list, specify your search criteria, and start the search. In the search results list, you can right-click Organizational Units and use commands on the shortcut menu to perform management tasks. For more information, see “Finding Objects” earlier in this document.

For step-by-step instructions on how to search for Organizational Units, see How To/Manage Organizational Units/Find an Organizational Unit in ActiveRoles Server Help.

Modifying Organizational Unit Properties

To modify properties of an OU, right-click the OU, and then click Properties. You can make changes to OU properties in the Properties dialog box, shown in the following figure.

In the Properties dialog box, some property labels may be displayed as hyperlinks. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. Property changes cannot be applied until you enter an acceptable value.

You can use the Properties dialog box to view or modify any property of the Organizational Unit: go to the Object tab and click Advanced Properties. In the Advanced Properties window you can manage all properties, including those that cannot be accessed via the Properties dialog box itself.

You can also display the Advanced Properties window as follows: right-click the Organizational Unit and select All Tasks | Advanced Properties.
For step-by-step instructions on how to manage Organizational Unit properties, see How To/Manage Organizational Units/Modify Organizational Unit properties in ActiveRoles Server Help.

**Renaming an Organizational Unit**

To rename an OU, right-click the OU, and click Rename. Type the new name and press ENTER.

For step-by-step instructions on how to rename Organizational Units, see How To/Manage Organizational Units/Rename an Organizational Unit in ActiveRoles Server Help.

**Moving an Organizational Unit**

To move an OU, right-click the OU, and click Move. In the Move dialog box, select the container to which you want to move the OU.

Microsoft Management Console version 2.0 or later provides the drag-and-drop function for moving objects. To move an OU, you can drag it to a destination container in the console tree.

For step-by-step instructions on how to move Organizational Units, see How To/Manage Organizational Units/Move an Organizational Unit in ActiveRoles Server Help.

**Deleting an Organizational Unit**

To delete an OU, right-click the OU, and click Delete. If the OU contains any objects, the Delete Objects dialog box appears. You can delete the OU and all objects it contains: select the Apply to all items check box, and click Yes.

For step-by-step instructions on how to delete Organizational Units, see How To/Manage Organizational Units/Delete an Organizational Unit in ActiveRoles Server Help.
Management of Contacts

- About Contacts
- Contact Management Tasks
About Contacts

A contact is an Active Directory object that holds e-mail and telephone information about an individual, without giving that person a security account on the network.

Contacts do not have a security identifier, unlike user accounts and groups. Contacts are used to add members to distribution lists or groups without granting them access to network resources.

You can use ActiveRoles Server to create, modify, and delete contacts. You can also perform Exchange-related tasks such as establishing email addresses for contacts.

The following section describes how to use the ActiveRoles Server console to manage contacts. You can also use the ActiveRoles Server Web Interface to perform contact management tasks.

Contact Management Tasks

This section covers the following tasks:

- Creating a contact
- Finding a contact
- Modifying contact properties
- Renaming a contact
- Adding and removing contacts from groups
- Performing Exchange tasks on a contact
- Moving contacts
- Exporting and importing contacts
- Deleting contacts
Creating a Contact

You can create a new contact as follows: in the console tree, right-click the container where you want to add the contact, select **New | Contact**, and then follow the instructions in the wizard.

In the wizard, some property labels may be displayed as hyperlinks. In the following figure, this is **Full name**. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on this property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. The wizard cannot proceed until you enter an acceptable value.

For step-by-step instructions on how to create contacts, see **How To/Manage Contacts/Create a contact** in ActiveRoles Server Help.

Finding a Contact

To find a contact, right-click the container you want to search and click **Find**. In the **Find** window, select **Contacts** from the **Find** list, specify your search criteria, and start the search. In the search results list, you can right-click contacts and use commands on the shortcut menu to perform management activities.

For step-by-step instructions on how to search for contacts, see **How To/Search for Objects/Search for a user, contact, or group** in ActiveRoles Server Help.
Modifying Contact Properties

To modify contact properties, right-click the contact, and then click Properties. You can make changes to contact properties in the Properties dialog box, shown in the following figure.

![Properties dialog box](image)

In the Properties dialog box, some property labels may be displayed as hyperlinks. The hyperlink indicates that ActiveRoles Server enforces certain policy restrictions on the property. To examine policy details, click the hyperlink: the policy information is displayed (see “Getting Policy-related Information” earlier in this document).

The policy information is also displayed whenever you supply a property value that violates a policy restriction. Property changes cannot be applied until you enter an acceptable value.

You can use the Properties dialog box to view or modify any property of the contact: go to the Object tab and click Advanced Properties. In the Advanced Properties window you can manage all properties, including those that cannot be accessed via the Properties dialog box itself.

You can also display the Advanced Properties window as follows: right-click the contact and select All Tasks | Advanced Properties.

In the console, you can select multiple contacts, right-click the selection, click Properties, and then modify properties of all the selected contacts collectively via the Properties dialog box.

The instructions on how to manage contact properties are similar to those for user accounts, see How To/Manage User Accounts/Modify user account properties in ActiveRoles Server Help.
Renaming a Contact

To rename a contact, right-click the contact and click Rename. Type a new name and press ENTER. This displays In the Rename Contact dialog box, you can change the first name, last name, and display name of the contact.

Adding and Removing Contacts from Groups

To add contacts to groups, select the contacts, right-click the selection, and click Add to a Group. This displays the Select Objects dialog box where you can select the groups to which you want to add the contacts (see "Adding User Accounts to Groups" earlier in this document).

You can also add or remove a contact from groups by modifying the group membership list on the Member Of tab in the Properties dialog box. To display the Properties dialog box, right-click the contact and click Properties. The Member Of tab looks as shown in the following figure.
The Member Of tab lists the groups to which the contact belongs. If the Show nested groups check box is selected, the list also includes the groups to which the contact belongs due to group nesting.

The Temporal Membership Settings button can be used to specify the date and time when the contact should be added or removed from the selected groups. For more information about this feature, see “Using Temporal Group Memberships” earlier in this document.

You can modify the list on the Member Of tab using the Add and Remove buttons. Clicking Add displays the Select Objects dialog box where you can type or select the names of the groups you want to add to the list. Clicking Remove deletes the selection from the list.

Performing Exchange Tasks on a Contact

To perform Exchange tasks on a contact, right-click the contact, click Exchange Tasks, and follow the instructions in the Exchange Task Wizard.

The Exchange Task Wizard helps you manage Exchange 200x recipients by providing a set of tasks that apply to the selected account. The list of tasks looks similar to that shown in the following figure.

For step-by-step instructions on how to perform Exchange tasks on contacts, see How To/Manage Exchange Recipients/Perform Exchange tasks on contacts in ActiveRoles Server Help.

Moving Contacts

To move contacts to another container, select the contacts, right-click the selection, and then click Move. In the Move dialog box, select the container to which you want to move the contacts.
Exporting and Importing Contacts

With the ActiveRoles Server console, you can export contacts to an XML file and then import them from that file to populate a container in a different domain. The export and import operations provide a way to relocate contacts between domains.

To export contacts, select them, right-click the selection, and select All Tasks | Export. In the Export Objects dialog box, specify the file where you want to save the data, and click Save.

To import contacts, right-click the container where you want to place the contacts, and then click Import. In the Import Directory Objects dialog box, select the file to which the contacts were exported, and click Open.

Deleting Contacts

To delete contacts, select them, right-click the selection, and click Delete. Then, click Yes to confirm the deletion. If you select multiple contacts, clicking Delete displays the Delete Objects dialog box. To delete all the selected contacts, select the Apply to all items check box, and then click Yes.

Deleting a contact is an irreversible operation. A new contact with the same name as a deleted contact does not automatically assume the same membership of distribution and security groups that the deleted contact had.
Management of Exchange Recipients

- About Exchange Tasks
- Exchange Tasks on User Accounts
- Exchange Tasks on Groups
- Exchange Tasks on Contacts
- Managing Exchange-related Properties
About Exchange Tasks

In the managed domains with Microsoft Exchange Server, ActiveRoles Server provides the ability to perform Exchange tasks and manage Exchange-related properties.

When creating a user account, the ActiveRoles Server console provides the option to create a user mailbox for that user. User mailboxes are the most commonly used mailbox type, and it is typically the mailbox type that is assigned to users in an Exchange organization.

Additionally, the console provides a number of commands for creating special-purpose mailboxes. On a container, such as an organizational unit, each of these commands creates a disabled user account along with a special-purpose mailbox associated with that account:

- **New | Room Mailbox**  Creates a mailbox that is assigned to a meeting location, such as a conference room, auditorium, or training room. Room mailboxes can be included as resources in meeting requests, providing a simple and efficient way of organizing meetings for your users.

- **New | Equipment Mailbox**  Creates a mailbox that is assigned to a non-location specific resource, such as a portable computer projector, microphone, or a company car. Equipment mailboxes can be included as resources in meeting requests, providing a simple and efficient way of utilizing resources for your users.

- **New | Linked Mailbox**  Creates a mailbox that is assigned to an individual user in a separate, trusted forest. Linked mailboxes may be necessary for organizations that choose to deploy Exchange in a resource forest. The resource forest scenario allows an organization to centralize Exchange in a single forest, while allowing access to the Exchange organization with user accounts in one or more trusted forests.

- **New | Shared Mailbox**  Creates a mailbox that is not primarily assigned to a single user and is generally configured to allow logon access for multiple users. The user account that is associated with a shared mailbox must be a disabled account. It is possible to specify a list of the mailbox users each of which will have full access to the shared mailbox.

For step-by-step instructions on how to create mailboxes, see How To/Manage Exchange Recipients/Create an Exchange mailbox in ActiveRoles Server Help.

The ActiveRoles Server console provides the Exchange Task Wizard to perform the following tasks on existing users, groups, and contacts:

- Create and delete user mailboxes.
- Create and delete special-purpose mailboxes.
- Establish external e-mail addresses for users, contacts, and groups.
- Delete external e-mail addresses for users, contacts, and groups.
- Move mailboxes to a different server, mailbox store, or mailbox database.
- Hide and unhide the membership of groups.
- Remove all Exchange settings (advanced, disaster-recovery task).

The following sections briefly describe the Exchange tasks available on user accounts, groups, and contacts.
Exchange Tasks on User Accounts

To perform Exchange tasks on user accounts, select one or more accounts, right-click the selection, click Exchange Tasks, and then follow the instructions in the wizard. Depending on the selected accounts, the following tasks are available.

If the user account is mailbox-enabled (the user account has an Exchange mailbox associated with it):

- **Delete Mailbox**  Deletes the mailbox for each selected user.
- **Move Mailbox**  Moves the mailboxes to a different server.
- **Remove Exchange Attributes**  Removes all Exchange attributes from each selected user account.

If the user account is mail-enabled (the user account has an associated e-mail address but does not have an associated Exchange mailbox):

- **Delete E-Mail Addresses**  Deletes the e-mail addresses from each selected user account.
- **Remove Exchange Attributes**  Removes all Exchange attributes from each selected user account.

If the user account is neither mailbox-enabled nor mail-enabled:

- **Create User Mailbox**  Creates a user mailbox for each selected user.
- **Create Room Mailbox**  Create a mailbox for room scheduling. The user account associated with this mailbox must be a disabled account.
- **Create Equipment Mailbox**  Create a mailbox for equipment scheduling. The user account associated with this mailbox must be a disabled account.
- **Create Linked Mailbox**  Create a mailbox that is assigned to a certain user in a separate, trusted forest. The user account associated with this mailbox must be a disabled account.
- **Create Shared Mailbox**  Create a mailbox that is configured to allow logon access for multiple users. The user account associated with this mailbox must be a disabled account.
- **Establish E-Mail Addresses**  Establishes an external e-mail address for each selected user.
- **Remove Exchange Attributes**  Removes all Exchange attributes from each selected user account.

For step-by-step instructions on how to perform Exchange tasks on user accounts, see How To/Manage Exchange Recipients/Perform Exchange tasks on user accounts in ActiveRoles Server Help.
### Exchange Tasks on Groups

To perform Exchange tasks on groups, select one or more groups, right-click the selection, click **Exchange Tasks**, and then follow the instructions in the wizard. The following tasks are available for groups:

- **Establish an E-Mail Address** Establishes an e-mail address for each selected group to configure it as a distribution list.
- **Delete E-Mail Addresses** Deletes the e-mail address from each selected group so that the group can no longer be used as a distribution list.
- **Hide Membership** Prevents viewing the membership of each selected group.
- **Unhide Membership** Allows viewing the membership of each selected group.
- **Remove Exchange Attributes** Remove all Exchange attributes from each selected group.

For step-by-step instructions on how to perform Exchange tasks on groups, see [How To/Manage Exchange Recipients/Perform Exchange tasks on groups](#) in ActiveRoles Server Help.

### Exchange Tasks on Contacts

To perform Exchange tasks on contacts, select one or more contacts, right-click the selection, click **Exchange Tasks**, and then follow the instructions in the wizard. The following tasks are available for contacts:

- **Establish E-Mail Addresses** Establishes an external e-mail address for each selected contact.
- **Delete E-Mail Addresses** Deletes the e-mail addresses from each selected contact.
- **Remove Exchange Attributes** Removes all Exchange attributes from each selected contact.

For step-by-step instructions on how to perform Exchange tasks on contacts, see [How To/Manage Exchange Recipients/Perform Exchange tasks on contacts](#) in ActiveRoles Server Help.

### Managing Exchange-related Properties

For Exchange recipients (mail-enabled users, contacts and groups, and mailbox-enabled users) the **Properties** dialog box includes the following tabs for managing Exchange-related properties:

- Exchange General
- E-mail Addresses
- Exchange Advanced
- Mailbox Features
- Resource Information
- Master Account
- Mailbox Sharing
Exchange General Tab

For a mailbox-enabled user, the Exchange General tab is used to set delivery restrictions, delivery options, and storage limits. You also can view the mailbox type, the mailbox store that holds the mailbox data, and view or modify the user’s e-mail alias.

From this tab, you can view or change the following settings:

- **Delivery Restrictions** Specify the maximum size of incoming and outgoing messages for the mailbox, and from whom the mailbox user can or cannot receive e-mail.
- **Delivery Options** Allow one or more users to send messages on behalf of the mailbox user, specify a forwarding address for messages addressed to the mailbox, and limit the number of recipients to whom the mailbox user can send a message.
- **Storage Limits** Specify storage limits that, when exceeded, result in the mailbox user being warned or prohibited from sending or receiving e-mail. You can also select the number of days a deleted item is retained in the mailbox store before it is permanently deleted.

For a user account or contact, you can use the Exchange General tab to perform the following tasks:

- View or modify the alias
- Create or modify the e-mail address
- Specify a message size limit
- Set delivery restrictions
For a group, you can use the **Exchange General** tab to perform the following tasks:

- View or modify the group’s alias and display name
- Specify a message size limit
- Set message restrictions

**E-mail Addresses Tab**

For a mailbox-enabled user or a mail-enabled recipient, the **E-Mail Addresses** tab is used to view, add, modify, or remove e-mail addresses. You can also use this tab to select a primary address if there are two or more addresses of the same address type.
Exchange Advanced Tab

For a mailbox-enabled user, the Exchange Advanced tab is used to select a simple display name, hide the user from the address lists, downgrade high priority e-mail bound for X.400, assign custom attributes, select Internet Locator Service (ILS) settings, and configure mailbox rights.

From this tab, you can access and manage the following properties:

- **Simple display name**  Type a simple display name for the mailbox-enabled user. The simple display name is used by systems that cannot interpret all of the characters in a normal display name.

- **Hide from Exchange address lists**  Use this option to prevent the mailbox-enabled user from appearing in address lists. If you select this option, the mailbox will be hidden from all address lists.

- **Downgrade high priority mail bound for X.400**  Use this check box to downgrade e-mail that is set for high priority delivery to an X.400-type e-mail address. The downgrade causes the outbound e-mail to conform to original 1984 X.400 conventions.

- **Custom Attributes**  Assign values to Exchange custom attributes. Exchange Server provides 15 custom attributes.

- **ILS Settings**  Specify the Internet Locator Service (ILS) server and ILS account name for the mailbox.

- **Mailbox Rights**  View and change mailbox permissions, assign mailbox permissions to users and groups, and change inherited permissions.
For a mail-enabled user or contact, you can use the **Exchange Advanced** tab to perform the following tasks:

- Specify a simple display name
- Hide the recipient from Exchange address lists
- Downgrade high priority mail bound for X.400
- Assign custom attributes
- Select Internet Locator Service (ILS) settings

For a mail-enabled group, you can use the **Exchange Advanced** tab to perform the following tasks:

- Select a simple display name
- Select an expansion server
- Hide the group from Exchange address lists
- Choose whether to send out-of-office messages to message originators
- Select delivery report options
- Assign custom attributes

### Mailbox Features Tab

The **Exchange Features** tab is used to enable or disable a variety of mailbox features for the mailbox user. You can also change configuration settings for Exchange ActiveSync, Post Office Protocol version 3 (POP3), and Internet Message Access Protocol Version 4 Rev 1 (IMAP4) by selecting the feature from the list, and then clicking **Properties**.
From this tab, you can enable or disable the following features:

- **Outlook Mobile Access** Allows the user to browse the mailbox with a cell phone or other wireless devices.
- **Exchange ActiveSync** Allows the user to access the mailbox from a mobile device.
  
  Select this setting, and then click **Properties** to apply an Exchange ActiveSync mailbox policy to the mailbox.

- **Up-to-date Notifications** Allows the user to apply notifications in order to keep the mailbox data on a mobile device always up to date.
- **IMAP4** Allows the user to access the mailbox from an IMAP4 client such as Outlook Express.
  
  Select this setting, and then click **Properties** to configure the MIME format of messages that are retrieved from the server for the mailbox. You can use the protocol default or specify a custom setting that takes precedence over the default protocol settings.

- **POP3** Allows the user to access the mailbox from a POP3 client such as Outlook Express.
  
  Select this setting, and then click **Properties** to configure the MIME format of messages that are retrieved from the server for the mailbox. You can use the protocol default or specify a custom setting that takes precedence over the default protocol settings.

- **Outlook Web Access** Allows the user to access the mailbox from a Web browser by using Microsoft Outlook Web Access.
- **MAPI** Allows the user to access the mailbox from a MAPI client such as Microsoft Outlook.

**Resource Information Tab**

On the **Resource Information** tab, you can view or change the resource mailbox settings. This tab is available only for resource mailboxes.

There are two types of resource mailboxes in Microsoft Exchange Server: room and equipment. **Room mailboxes** are assigned to a meeting location such as a conference room, auditorium, or training room. **Equipment mailboxes** are assigned to a resource that is not location specific, such as a portable computer projector, microphone, or company car. The following fields provide users with additional information about the resource:

- **Resource capacity** Use this box on the **Resource Information** tab to type the capacity the resource can handle. For example, for a room mailbox, you can specify the number of people the room can accommodate. The value range is from 0 through 2,147,483,647.

- **Resource custom properties** Custom resource properties can help users select the most appropriate room or equipment by providing additional information about the resource. For example, suppose a custom property for room mailboxes called **Audio-Visual** is defined in your Exchange organization. You can add this property to the room mailboxes for the rooms that have audio-visual equipment. This allows users to identify which conference rooms have audio-visual equipment available.

  Click the **Add** button on the **Resource Information** tab to open a dialog box allowing you to select custom properties. The dialog box displays a list of all custom resource properties that are defined in your Exchange organization for the specific resource type (room or equipment). Select the custom resource properties you want to assign to this mailbox, and then click **OK**.

  Use the **Remove** button to remove custom resource property from the resource mailbox.

For step-by-step instructions on how to create a room or equipment mailbox, see **How To/Manage Exchange Recipients/Create an Exchange mailbox** in ActiveRoles Server Help.
Master Account Tab

Use the Master Account tab to view or change information about the master account for the linked mailbox. This tab is available only for linked mailboxes.

Linked mailboxes are mailboxes that are accessed by users in a separate, trusted forest. Linked mailboxes may be necessary for organizations that choose to deploy Exchange in a resource forest. The resource forest scenario allows an organization to centralize Exchange in a single forest, while allowing access to the Exchange organization with user accounts in one or more trusted forests. The linked master account is the user account that will be used to access the linked mailbox.

From the Master Account tab you can view the current master account or choose a different master account for the linked mailbox. Click the Browse button next to the Linked master account box and then use the Select Objects dialog box to select the user account you want to be used to access this linked mailbox. Select a user account from a forest or domain trusted by the forest or domain where Exchange is deployed.

For step-by-step instructions on how to create a linked mailbox, see How To/Manage Exchange Recipients/Create an Exchange mailbox in ActiveRoles Server Help.

Mailbox Sharing Tab

Use the Mailbox Sharing tab to view or change information about the users who have full access to the shared mailbox. This tab is available only for shared mailboxes.

Shared mailboxes are generally configured to allow logon access for multiple users. Although it is possible to grant additional users the logon rights to any mailbox type, shared mailboxes are dedicated for this functionality. The user account that is associated with a shared mailbox must be a disabled account. From this page, you can grant permissions to all users that require access to the shared mailbox.

From this tab, you can view or change a list of mailbox users. These are the users who can log on to the shared mailbox and have full access to the mailbox contents. They can use the mailbox to send and receive messages, manage contacts, schedule meetings, and maintain a task list. You can add or remove mailbox users:

- Click the Add button on the Mailbox Sharing tab and then use the Select Objects dialog box to select the users you want to have full access to the shared mailbox.
- If you want a certain user to no longer have access to the shared mailbox, select that user from the Mailbox users list and click the Remove button.

For step-by-step instructions on how to create a shared mailbox, see How To/Manage Exchange Recipients/Create an Exchange mailbox in ActiveRoles Server Help.